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Files included on this CD-ROM Contents?

Introduction and shoreline habitat photos

Legend and how to interpret ESI maps

Index map showing ESI map coverages

Seasonality tables

Metadata

For more information about the contents
of this CD-ROM, please continue.



Files included on this CD-ROM
(cont.)

Contents

Directory named according to state (e.g., CALIF, S_CAROL).
This directory contains this Online Guide (GUIDE.PDF) and a
Directory named according to state (e.g., CALIF, S_CAROL).
This directory contains this Online Guide (GUIDE.PDF) and a
directory called ESI_DATA which contains the Index map, ESI
maps, Seasonality tables, associated Introduction and Legend
files, and a technical file about the actual data used in the ESI
maps.
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Files included on this CD-ROM
(cont.)

Contents?

Within the ESI_DATA directory are the following files and sub-
directories:

Introduction discussion (INTRO.PDF).  This file is a text
introduction to the ESI Atlas that explains the purpose and
content of the atlas.  It lists animal species in the area, gives
contacts for human-use features such as parks and marinas, and
describes the various shoreline habitats found in the area.

Legend of symbols used, and discussion on how to interpret
ESI maps (LEGEND.PDF).  This file tells what each color and
symbol used in the ESI maps stands for and gives tips for
interpreting the map information.
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Contents?Files included on this CD-ROM
(cont.)

Index map (INDEX.PDF).   This file is a map of the entire state
with the ESI map coverages outlined.  The coverage boxes are
linked to the screen resolution ESI map pages.  Just click the box
to jump to the associated ESI map.

Seasonality tables (SEASON.PDF).  This file lists the seasonal
species data associated with each ESI map.  The table shows each
species present in the area, whether they are on any State or
Federal threatened or endangered species lists and the level of
concern, which months the species is present, and the times of
various life stages such as nesting or spawning.
The map titles at the top of the page are linked back to the actual
ESI map, so to view the ESI map associated with the table, click
the title.
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Contents?Files included on this CD-ROM
(cont.)

High-resolution ESI maps (MAPS).   This directory contains
300-dpi ESI maps.  These maps are accessed through the 
Index map and are associated with the Seasonality tables.
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The titles of these maps are linked to the Seasonality tables, so to
see the seasonality data for a map, click on the map title.



Contents?Files included on this CD-ROM
(cont.)

Document on how the data was compiled and digitized
(METADATA.PDF).   This file provides the technical
documentation about the data shown on the ESI maps.  It details
the quality standards for the data, discusses how the spatial data
was organized and referenced, and gives complete information
about the entities and attributes portrayed on the maps.
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Contents?How to navigate

Viewing the Index map.  Click on the "Index map" text on the "Files
Included on this CD-ROM" section of this guide.  From there, you can
link to the individual ESI maps by clicking in the coverage boxes.

Returning to the Index map.  Click         from the toolbar to return to the
Index map from an ESI map.  (NOTE:  This button returns to the
previous view, so if you zoomed into the ESI map, the button will
return to the unzoomed view.  Click the button again to return to the
Index map.)



Contents?

Viewing the Seasonality data.  Click the title of the ESI Map.  Seasonality
pages are included only for the areas where biology data was collected
in 2001.  These include the areas spanning the large index boxes titled
Bering Glacier, Icy Bay, Mt. Fairweather, Mt. St. Elias, Yakutat and 
part of Juneau.  
ESI Maps which do not have associated seasonality data return the user
to the Index Map when the title of the map is clicked.

How to navigate (cont.) 

Returning to the ESI map.  Close the Seasonality table, click the ESI map
name on the Seasonality page, or navigate using the Window menu.
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Viewing unlinked ESI maps.  Some ESI maps have no link from the
Index Map or the Seasonality data.  Those maps must be accessed from
the CD-ROM directly.



Contents?How to navigate (cont.)
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For an alternate method of navigation where it is possible to keep multiple files open and
to toggle between files using the Window menu, please continue.
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Contents?Alternate navigation
Instead of using the       button, there is an alternate way to navigate
among all of the documents on this CD-ROM, but it requires you to
change a preference in the Reader 3.0 application.  Once this preference
is set, multiple files can stay open at the same time.  To toggle back and
forth, you simply have to select the file you are interested in from the
Window menu.

To change the preference:
 •  Go to the File menu and select Preferences
 •  Choose General
 •  In the dialogue box that opens up, UNCHECK the "Open Cross
     Document Links in Same Window" option.
 •  Select OK.

Once set, the preference will remain, so you will not have to open the
dialogue again the next time you use this CD-ROM.
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Contents?Alternate navigation (cont.)

Viewing the Index map.  Click on the "Index map" text on the "Files
Included on this CD-ROM" section of this guide.  From there, you can
link to the individual ESI maps by clicking in the coverage boxes.

Returning to the Index map.  Choose "INDEX.PDF" from the Window
menu.

Viewing the Seasonality data.  Click the title of the ESI map.

Returning to the ESI map.  Click the map name at the top of the
Seasonality table.
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Contents?Alternate navigation (cont.)
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For some odd reason, this had to
be over here, because .pdf writer
kept moving it to the right.  The
spacing looks ok with it here.
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To print a page from this CD-ROM, open the file you wish to print and
select "Print" from the File menu.  
These files can be printed on any Postscript® compatible printer.  
The maps are in 11"x17" format, so you will need to adjust the map
size accordingly to fit your printer output.  Select "Shrink to fit" or "Fit
to page" from your Page Setup menu to automatically scale the map
to paper sizes other than 11"x17".

How to print ESI maps
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The procedure for having the maps printed at a commercial printshop
will vary depending on where you go.  The computer that you use will
need Acrobat Reader 3.0 (or later).  The computer must have the 3.0
version (or later) because using an older version will cause irregularities
in viewing and printing.

In order to give you a general idea of what might be involved, here are
the printing costs from a local printshop:  We used a computer for 10
minutes, which cost $4.00.  There was a one-time $10.00 charge for the
use of another computer that was used to set up the print files for the
color copier (which was the only machine with 11"x17" color printing
capability).  Then, each color copy cost $1.99, but this charge decreases
with volume.  So to print two pages was about $19.50 (incl. tax), or
about $9.75 per page.  To print 50 pages would have been about $125.00
(incl. tax), or about $2.50 per page.

How to print ESI maps (cont.)
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The most widely used approach to sensitive environment mapping in
the United States is NOAA’s Environmental Sensitivity Index (ESI)
approach. This approach systematically compiles information in
standard formats for coastal shoreline sensitivity, biological resources,
and human-use resources. The ESIs are an important tool in emergency
spill response, where their use helps to reduce the environmental
consequences of the spill and cleanup efforts.



Contents?About ESI mapping (cont.)

The primary objective of spill response in the United States, after
protecting human life, is to reduce the environmental consequences of
the spill and cleanup efforts.  This objective is best achieved when ESI
maps are used to identify the locations of sensitive resources before a
spill occurs, so that protection priorities can be established and cleanup
strategies developed in advance.  Since their inception in 1979, ESI
atlases have been prepared for most of the U.S. shoreline, including the
Great Lakes, Alaska, Hawaii, and the Trust Territories.
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To be effective, sensitive environment mapping must be an integral
component of overall spill planning activities.  Sensitivity maps are not
an end in themselves, rather they are a starting point for prevention,
planning, and response actions. The definitions in the NOAA
sensitivity maps provide guidance that local organizations use to
develop plans. Recently published manuals, including the Mechanical
Protection Guidelines  and the Shoreline Countermeasures  series for
temperate, tropical, Arctic, and freshwater environments are examples
where the ESI definitions are the basis for site-specific planning.

About ESI mapping (cont.)
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Contents?About ESI mapping (cont.)

There are three general types of information found in ESI maps:
habitats ranked according to geomorphological characteristics,
sensitivity to spilled oil, natural persistence of oil, and ease of cleanup;
biological resources including oil-sensitive animals and plants, with
information at the species level;  and human-use resources, such as
high-use amenity beaches, parks, and marine sanctuaries.  The
intertidal habitat ranking scheme is based on an understanding of the
complete coastal environment, not just the substrate type and grain size.
Key to the rankings is an understanding of the relationships between
physical processes and substrates that produce specific geomorphic
shoreline types and predictable patterns in oil behavior and sediment
transport patterns.  The habitat ranking system has been widely
incorporated into spill decision-making aids including manuals,
matrices, and planning documents.
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Contents?About ESI mapping (cont.)

Recent work has focused on extending the original methodology for
open coastal areas to inland rivers, and smaller ponds and streams.  The
strategy emphasizes standard map formats for electronic and hard-copy
output.  NOAA is undertaking a comprehensive program to provide
electronic access to new ESI data and to existing data formerly available
only as hard-copy maps.  Our strategy is to make digital ESI data
available on CD-ROM and via the Internet.  Selected ESI atlases will be
available in Portable Document Format for viewing and printing and in
formats appropriate for use with Geographic Information System
software.
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Contents?About ESI mapping (cont.)

For more information about ESI maps, contact the Hazardous Materials
Response and Assessment Division at:

NOAA / HAZMAT
7600 Sand Point Way N.E.
Seattle, WA 98115

E-mail: library@hazmat.noaa.gov

Or, visit the ESI Home Page at:
http://response.restoration.noaa.gov/esi/esiintro.html

ESI  ATLASES

http://response.restoration.noaa.gov/esi/esiintro.html
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NOAA - Hazardous Materials Response & Assessment Division

About the producers

?Click on the name of a producer to get additional information from their website.
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NOAA - Coral Reef Conservation Program

http://response.restoration.noaa.gov/
http://www.coralreef.noaa.gov/



